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BAB 2 
Memahami Fitur-Fitur    
Program AutoCAD   

 
 

 
 
Setiap release pada program AutoCAD pasti terdapat penambahan  
fasilitas (fitur) baru, di mana jenis-jenis fasilitas baru (New Features 
Workshop) tersebut biasanya ditampilkan ketika Anda akan mulai  
menjalankan program AutoCAD.   

Meskipun terdapat fitur baru pada setiap release, namun menu (tools) 
utama pada AutoCAD pada dasarnya sama dalam setiap release. 
Sebagai contoh, jika kita gunakan AutoCAD 2009, maka pada saat 
membuka program akan ditampilkan kotak dialog New Features 
Workshop. Berikut fitur baru AutoCAD beberapa release.    

a. Pada kotak dialog New Features Workshop AutoCAD 2009 pilih 
Yes seperti yang terlihat pada gambar di bawah. 

 
Gambar 2.1 Kotak diaIog New Features Workshop  
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b. Klik OK, setelah itu akan muncul kotak dialog New Features 
Workshop. Pada kotak dialog New Features Workshop Anda 
akan ditawarkan beberapa pilihan untuk melihat beberapa fitur 
baru, seperti terlihat pada gambar di bawah. 

 
Gambar 2.2 Kotak diaIog New Features Workshop AutoCAD 2009  

c. Jika Anda menggunakan AutoCAD 2011, maka tampilan program 
pertama setelah dibuka sebagai berikut.     

 
Gambar 2.3 Kotak diaIog Welcome Screen AutoCAD 2011  



17 

Fitur baru yang ada pada AutoCAD biasanya dijelaskan secara 
interaktif dalam bentuk animasi sehingga sangat memudahkan bagi 
pengguna AutoCAD untuk menjalankan program tersebut.  

Untuk memperjelas pembahasan buku, berikut akan dijelaskan bebe-
rapa fitur baru yang terdapat pada AutoCAD 2009 di bagian User 
Interface (diambil release yang masih banyak penggunanya).   

2.1 Application Window  
AutoCAD 2009 menawarkan kemudahan bagi penggunanya, ini 
terlihat dari tampilan interface-nya. Pada tampilannya, AutoCAD 2009 
sudah dilengkapi dengan berbagai informasi perintah gambar 
sehingga akan mempercepat penggunanya untuk mengaplikasikan.  

AutoCAD 2009 telah dilengkapi Quick Access Toolbar, yang   
merupakan perangkat pada program AutoCAD 2009 dan berfungsi 
untuk mempermudah serta mempercepat Anda dalam mengakses 
perintah yang sering Anda gunakan. 

Defauft dari Quick Access Toolbar akan menampilkan ikon perintah 
Qnew, Open, Save, Plot, Undo, dan Redo. Anda dapat menam-
bahkan perintah pada Quick Access Toolbar dengan cara berikut.  

a. Klik kanan pada Quick Access Toolbar seperti terlihat pada 
gambar di bawah. 

 
Gambar 2.4 Cara menampilkan Costumize Quick Access Toolbar 

b. Akan muncul kotak dialog Costumize User Interface. Drag ikon 
perintah yang Anda inginkan kemudian letakkan (masukkan) pada 
Quick Access Toolbar seperti contoh Gambar 2.5. 

c. Klik Apply > klik OK.  
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Gambar 2.5 Meletakkan perintah gambar  

pada Quick Access Toolbar 

2.2 Bidang Kerja AutoCAD   
Bidang Kerja (Workspace) merupakan perangkat untuk menampilkan 
dan menyimpan tampilan suatu bidang kerja pada AutoCAD dengan 
suatu spesifikasi dan karekteristik sesuai dengan kebutuhan dari 
penggunanya, sehingga diharapkan dapat mempertinggi nilai efisiensi 
kerja bagi penggunanya.  

Workspace dapat berupa toolbar, palette, menu browser, menubar 
atau ribbon yang sering Anda gunakan dalam AutoCAD pada waktu 
tertentu. Workspace yang disediakan AutoCAD 2009, antara lain 2D 
Drafting & Annotation, 3D Modeling, dan AutoCAD Classic. De-
fault dari tampilan workspace pada AutoCAD 2009 adalah 2D Draft-
ing & Annotation.    

Anda dapat mengganti workspace menggunakan menu browser de-
ngan langkah sebagai berikut.  

a. Klik ikon Menu Browser  pada program AutoCAD 2009.  

b. Pilih menu Tools > Workspace > pilih workspace misalnya: 3D 
Modeling.  
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Gambar 2.6 Proses memindahkan Workspace menjadi 3D Modeling 

Workspace juga dapat diganti dengan menggunakan ikon Work-
space Switching  yang terletak pada status bar seperti pada gam-
bar di bawah.   

 
Gambar 2.7 Letak ikon Workspace Switching pada status bar  

Selain workspace yang disediakan oleh AutoCAD, Anda dapat pula 
menyusun sendiri workspace yang Anda inginkan kemudian disimpan 
dengan nama tertentu.   

Metode untuk menyimpan bidang kerja (workspace) bisa dilakukan 
dengan berbagai cara, yaitu melalui Menu Browser atau melalui ikon 
Workspace Switching yang terletak pada baris status (status bar). 
Langkah-langkahnya sebagai berikut.  

a. Klik ikon Menu Browser  pada interface program AutoCAD 
2009. 

b. Pilih menu Tools > Workspace > Save Current As. 
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Gambar 2.8 Proses menyimpan bidang kerja 

c. Setelah keluar kotak dialog Save Workspace > ketik nama 
bidang kerja (misalnya Bidang Kerja 01) > klik tombol Save. 

  
Gambar 2.9 Subkotak dialog Save Workspace 

Apabila Anda bekerja dengan beberapa bidang kerja, maka Anda bisa 
kembali menampilkan bidang kerja yang dijadikan sebagai default. 
Secara default bidang kerja (workspace) pada AutoCAD 2009 adalah 
2D Drafting & Annotation, namun Anda dapat menentukan bidang 
kerja yang akan dijadikan default setelah sebelumnya Anda lakukan 
pengaturan pada kotak dialog Workspace Settings.  

Adapun metode untuk membuat default bidang kerja pada Work-
space Setting adalah sebagai berikut. 

a. Klik ikon Workspace Switching  pada status bar > pilih Work-
space Setting.  

  
Gambar 2.10 Proses menampilkan kotak dialog Workspace Settings 

b. Melalui bagian My Workspace pada kotak dialog Workspace 
Settings pilih bidang kerja yang akan dijadikan default setiap kali 
program AutoCAD 2009 dijalankan.  
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Gambar 2.11 Koptak dialog Workspace Settings  

c. Kotak daftar Menu Display and Order berfungsi untuk 
menentukan workspace mana saja yang akan ditampilkan pada 
toolbar Workspace. Move Up dan Move Down berfungsi untuk 
mengatur urutan tampilan pada Workspace.  

d. Apabila Anda ingin menyimpan perubahan bidang kerja 
(workspace) aktif secara otomatis. Aktifkan Automatically save 
workspace changes pada bagian When Switching Work-
spaces > klik OK untuk mengakhiri.   

 

Gambar 2.12 Bagian When Switching Workspaces 

Berikut keterangan dan penjelaskan interface AutoCAD 2009 yang 
dapat Anda gunakan sebagai alternatif dalam proses penggambaran. 

2.2.1 2D Drafting & Annotation  

Jenis workspace 2D Drafting & Annotation sangat membantu dalam 
membuat sebuah pemodelan objek 2D, karena dalam 2D Drafting & 
Annotation terdapat Ribbon yang isinya merupakan perintah yang 
bisa digunakan untuk menggambar objek 2D.   
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Gambar 2.13 Tampilan antarmuka (Interface) AutoCAD 2009  

pada    Workspaces 2D Drafting & Annotation 

Jenis workspace 2D Drafting & Annotation merupakan sebuah ling-
kungan bidang kerja 2D dengan seting fasilitas yang sangat relevan 
dengan keperluan penggambaran objek 2D, yaitu Menu Browser, ba-
ris menu (Menu Pull-down), panel Ribbon (Ribbon panel) yang terdiri 
atas berbagai perangkat, seperti Draw, Modify, Layers, Annotation, 
Properties dan lain-lain.   
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2.2.2 3D Modeling   

 
Gambar 2.14 Tampilan antarmuka (Interface) AutoCAD 2009  

pada Workspaces 3D Modeling 

Ketika Anda akan membuat desain objek 3D, pilihan menggunakan 
workspace 3D Modeling sangat tepat. Bidang kerja (workspace) 3D 
Modeling merupakan jenis bidang kerja yang sudah dilengkapi 
dengan berbagai fasilitas. Seperti 3D Modeling,  Draw, Solid Editing, 
Modify, View, serta Dashboard dan lain-lain yang berfungsi mendu-
kung penggambaran. 3D Modeling merupakan jenis bidang kerja 
yang sudah dilengkapi dengan fasilitas untuk penggambaran dan 
finishing desain visual 3D.   

Melalui bidang kerja (workspace) 3D Modeling, Anda bisa melakukan 
penggambaran secara interaktif, sehingga efek penggambaran objek 
3D bisa langsung dilihat pada saat proses penggambaran dan 
finishing desain visual 3D tersebut.  
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2.2.3 AutoCAD Classic  

Tampilan interface AutoCAD 2009 dalam bidang kerja AutoCAD 
Classic secara garis besar mirip/sama dengan tampilan pada release 
sebelumnya. Hal yang membedakannya dengan tampilan 2D Drafting 
& Annotation dan 3D Modeling adalah pada AutoCAD Classic tidak 
terdapat Ribbon panel.  

Interface AutoCAD 2009 dalam bidang kerja AutoCAD Classic  
adalah sebagai berikut.  

 
Gambar 2.15 Tampilan antarmuka (Interface) AutoCAD 2009                        

dengan Workspace AutoCAD Classic  

Secara garis besar, elemen interface dalam program AutoCAD 2009 
terdiri atas beberapa bagian sebagai berikut.  

a. Bagian atas terdapat Menu Browser, Quick Acces Toolbar, Ti-
tle Bar, Info Center dan Ribbon Panel. 

b. Bagian tengah terdapat Drawing Area Model Space, Crosshair, 
dan UCS Icon. 
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c. Pada bagian bawah dari jenis bidang kerja (workspace) terdapat 
Status Bar dan Command line.  

2.3 Menu Browser  
Menu Browser adalah jenis perangkat pada AutoCAD 2009 yang 
berfungsi untuk mengakses atau mencari perintah-perintah untuk 
menggambar yang Anda butuhkan dalam AutoCAD 2009. Fungsi 
lainnya sebagai fasilitas untuk melihat beberapa file yang telah Anda 
kerjakan/buka sebelumnya. Juga untuk melihat beberapa file yang 
sedang bekerja serta untuk melihat perintah gambar yang telah Anda 
gunakan sebelumnya.    

Menu Browser dibagi menjadi dua kelompok bagian, yaitu bagian 
Find Menu Command dan View and Open Document.  

 
Gambar 2.16 Kelompok Menu Browser pada AutoCAD 2009 

2.3.1 Find Menu Commands  

Find Menu Commands merupakan kelompok pada Menu Browser 
yang di dalamnya terdapat kumpulan dari semua perintah yang 
disediakan AutoCAD 2009 dan ditampilkan dalam satu tempat. 
Contoh aplikasi Menu Browser untuk memanggil perintah adalah 
sebagai berikut.     
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a. Klik ikon Menu Browser  pada interface program AutoCAD 
2009.   

b. Pilih Draw > Line > Anda dapat memulai pembuatan garis.   

 
Gambar 2.17 Cara menggunakan Menu Browser 

c. Klik Enter untuk mengakhiri. 

Cara lain aplikasi Menu Browser dengan fasilitas Search menu 
untuk memanggil perintah Line adalah sebagai berikut.  

a. Klik ikon Menu Browser  pada interface program AutoCAD 
2009. 

b. Ketik perintah yang Anda inginkan, misalnya Line (ketik Line) 
pada fasilitas Search menu.  

c. Setelah Anda mengetikkan kata yang Anda cari maka AutoCAD 
2009 akan memunculkan pada daftar menu pada Search menu.  

d. Untuk menjalankannya, klik perintah yang dicari, misalnya Line.   
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Gambar 2.18 Cara search pada menu Browser 

2.3.2 View and Open Documents  

View and Open Document merupakan kelompok pada Menu 
Browser, di mana fungsinya sebagai fasilitas untuk melihat beberapa 
file yang telah Anda kerjakan/buka sebelumnya. Selain itu View and 
Open Document juga bisa digunakan untuk melihat beberapa file 
yang sedang bekerja serta untuk melihat perintah gambar yang telah 
Anda gunakan sebelumnya.  

Pada View and Open Document terdapat 3 tiga fasilitas sebagai 
berikut.  

a. Recent Document, fungsinya untuk melihat file/dokumen yang 
telah Anda kerjakan atau Anda buka sebelumnya. 

b. Open Document, fungsinya untuk melihat file yang sedang Anda 
kerjakan atau buka (dalam keadaan aktif). 

c. Recent Action, fungsinya untuk melihat  beberapa perintah yang 
telah Anda gunakan sebelumnya dengan menggunakan fasilitas 
menu browser. 
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Gambar 2.19 Menu Browser Recent Document dan Open Document 

 
Gambar 2.20 Menu Browser Recent Actions 
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2.4 Menggunakan Ribbon 
Ribbon adalah fasilitas pada AutoCAD 2009 yang menampilkan ikon-
ikon perintah yang mempunyai karekteristik yang sama dalam proses 
penggambaran objek. Ikon-ikon pada Ribbon dikelompokkan pada 
masing-masing tab dengan beberapa panel sehingga menampilkan 
tampilan interface yang memudahkan pengguna dalam menggambar. 

 
Gambar 2.21 Tampilan ribbon panel  

Berikut penjelasan ikon-ikon perintah pada masing-masing panel 
yang terdapat pada Ribbon. 

A. Ribbon pada tab Home  

 
Gambar 2.22 Tampilan ribbon panel Draw dan Modify  

Keterangan: 

1. Berisi perintah Line, Arc, Pline, Polygon, Rectangle. 

2. Berisi perintah Circle, Ellipse, dan Hatch. 

3. Berisi perintah Xline, Ray, Points, dan Spline. 

4. Berisi perintah Gradient, Boundary, Region, Cloud. 

5. Berisi perintah 3D Polyline, Helix, dan Donut. 

6. Berisi perintah Move, Copy, Rotate, Stretch, Scale, Offset, Mirror. 

7. Berisi perintah Erase, Explode, Trim, Extend, Fillet, dan Break. 
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8. Berisi perintah Array, Break at Point, Join, dan Lengthen. 

9. Berisi perintah Edit Pline, Edit Spline, dan Edit Hatch.  

  
Gambar 2.23 Tampilan ribbon panel Layers  

Keterangan: 

10. Perintah Layer Properties, Layer State Manager, Freeze,dan 
Thaw. 

11. Kumpulan perintah Match, Previous, dan Layer Control. 

12. Perintah On/Off Layer, Lock/Unclock Layer, Change to Current 
Layer, Copy Object to New Layer, Layer Walk, Merge, dan 
Delete. 

13. Locked Layer Fading berfungsi untuk membuat tampilan dari 
layer yang terkunci (lock) menjadi kabur dengan tujuan untuk 
membedakan dengan layer lainnya yang aktif. Untuk menentukan 
besarnya persentase fading geser slider, semakin besar persen-
tasenya, warna objek akan semakin kabur.  

 
Gambar 2.24 Tampilan ribbon panel Annotation, Block, dan Utilities  

Keterangan: 

14. Perintah Multiline Text, Single Line Text, Multileader. 
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15. Untuk pengaturan jenis-jenis teks (huruf). 

16. Untuk mengatur tinggi teks (huruf). 

17. Untuk mengatur jenis-jenis dimensi (ukuran). 

18. Untuk mengatur jenis-jenis multileader. 

19. Untuk mengatur jenis-jenis penggunaan tabel.  

20. Kumpulan perintah untuk membuat Block, melakukan editing 
pada objek block dan perintah untuk melakukan penyisipan block. 

21. Kumpulan perintah untuk membuat atribut, melakukan editing 
pada objek atribut dan mengatur atribut. 

22. Kumpulan perintah untuk melakukan perbesaran gambar atau 
Zoom, perintah copyclip, paste, cut dan perintah untuk meng-
geser area kerja atau Pan. 

 
Gambar 2.25 Tampilan ribbon panel Properties  

Keterangan: 

23. Perintah Match Properties, List, Select Color dan Select Linetype.  

24. Merupakan perintah untuk memilih ketebalan garis. 

B. Ribbon pada tab Block & References  

 
Gambar 2.26 Tampilan ribbon panel Block dan Attributes  

Keterangan: 

25. Perintah untuk membuat Block, melakukan editing pada objek 
block dan perintah untuk melakukan penyisipan block. 



32 

26. Perintah Set Base Point untuk menentukan titik penyisipan atau 
base point dari objek block. 

27. Perintah untuk membuat atribut, melakukan editing pada objek 
atribut, dan mengatur atribut. 

 
Gambar 2.27 Tampilan Ribbon panel Reference, Import dan Content  

Keterangan: 

28. Perintah untuk menentukan batas objek gambar dengan jenis 
ekstensi DWF dan DGN. 

29. Perintah untuk menentukan batas objek Xref dan objek Image. 

30. Perintah untuk menyisipkan objek DWG, DWF, DGN, objek 
gambar atau image dan external reference. 

31. Perintah untuk melakukan impor file dengan ekstensi DXB dan 
WMF. 

32. Perintah untuk melakukan impor dengan ekstensi yang dapat 
dipilih. 

33. Perintah untuk melakukan impor file dengan ekstensi 3DS dan 
ACIS. 

 
Gambar 2.28 Tampilan ribbon panel Content  

34. Perintah untuk melakukan pengaturan atau untuk menyisipkan 
objek block, xerf, dan arsiran atau hatch pattern. 
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C. Ribbon pada tab Annotate  

 
Gambar 2.29 Tampilan ribbon panel Text dan Dimensions  

Keterangan: 

35. Perintah untuk memilih jenis huruf. 

36. Untuk melakukan pengaturan teks. 

37. Merupakan perintah untuk mencari teks. 

38. Untuk melakukan pengaturan pada multiline teks. 

39. Untuk menyisipkan teks yang dapat dilakukan update. 

40. Untuk melakukan pengaturan terhadap Dimensions/dimensi.   

41. Jenis-jenis perintah Dimensions untuk membuat ukuran/dimensi.   

42. Tombol Dimension Style.  

 
Gambar 2.30 Tampilan Ribbon panel Multileaders,                                         

Tables dan Markup  

Keterangan: 

43. Merupakan kumpulan perintah Multileader untuk memberikan 
keterangan atau penjelasan pada gambar. 

44. Tombol Multileader Style. 

45. Perintah menggunakan Table, mengambil data pada table, upload 
data ke dalam tabel. 

46. Tombol Table Style. 
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47. Perintah Revision Cloud dan Wipeout digunakan untuk mem-
berikan tanda pada bagian-bagian gambar yang mengalami revisi 
atau perubahan sehingga Anda dapat mengetahui dengan cepat 
bagian yang diubah tersebut. 

D. Ribbon pada tab Tools  

 
Gambar 2.31 Tampilan ribbon panel Inquiry dan Customization  

Keterangan: 

48. Inquiry berfungsi untuk menentukan jarak antara dua titik, mencari 
parameter objek dan luas objek, untuk menentukan letak suatu 
titik, menampilkan data properti suatu objek.  

49. User Interface berfungsi untuk melakukan pengaturan pada 
toolbar atau interface yang disesuaikan dengan kebutuhan 
pengguna. 

50. Tool Palettes digunakan untuk menampilkan masing-masing 
palette, membuat palette baru sesuai dengan kebutuhan, mela-
kukan editing pada palette, mengubah nama palette. 

E. Ribbon pada tab View  

 
Gambar 2.32 Tampilan ribbon panel UCS dan Viewports  

Keterangan: 

51. Merupakan kumpulan perintah untuk menampilkan World UCS, 
perintah untuk menyimpan UCS, menentukan UCS origin, me-
mutar UCS berdasarkan sumbu X,Y,Z.  
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52. Untuk menentukan UCS berdasarkan Z-Axis. 

53. Untuk menentukan UCS berdasarkan permukaan. 

54. Untuk menentukan UCS berdasarkan 3 titik. 

55. Untuk menampilkan simbol UCS. 

56. Perintah untuk memilih jenis-jenis layout yang telah tersedia. 

57. Berfungsi untuk mengatur layout area kerja atau membuat 
sebuah layout baru.  

 
Gambar 2.33 Tampilan ribbon panel Palettes  

58. Tombol tool Palettes, berfungsi untuk menampilkan masing-
masing Palette, membuat palette baru sesuai dengan kebutuhan 
melakukan editing pada palette, mengubah nama palette. 

59. Berisi kumpulan perintah Command Line, Quick Calc, External 
Reference, Layer Properties, Design Center.    

2.5 Menggunakan Quick Properties  
Quick Properties merupakan fasilitas untuk menampilkan informasi 
properties yang terdapat pada tiap-tiap objek secara umum sehingga 
mempermudah untuk menemukan dan memodifikasi objek tersebut. 
Quick properties pada prinsipnya hampir sama dengan Properties, 
namun informasi yang dimunculkan tidak selengkap Properties. 

Untuk mengaktifkan dan menonaktifkan Quick Properties dapat 
menggunakan ikon  yang tedapat pada baris status (status bar).    

 
Gambar 2.34 Letak Quick Properties pada status bar 
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Gambar 2.35 Kotak dialog Quick Properties 

2.6 Menggunakan Quick View 
Quick View merupakan fasilitas untuk melihat dan berpindah-pindah 
file gambar yang aktif dan berpindah antar-layout pada sebuah file 
gambar yang ditampilkan oleh AutoCAD 2009. Quick View terdiri atas 
Quick View Drawings dan Quick View Layouts, yang keduanya 
terletak pada baris status (status bar).    

 
Gambar 2.36 Letak Quick View pada status bar 

2.6.1 Quick View Drawings 

Quick View Drawings berfungsi menampilkan semua file gambar 
aktif yang akan ditampilkan dalam bentuk thumbnail. Gambar layout 
dan tab model yang terdapat pada file tersebut akan ditampilkan 
dalam satu baris.  

Quick View Drawings juga membantu Anda untuk berpindah antar- 
file gambar ke file gambar yang Anda kehendaki.  

2.6.2 Quick View Layouts   

Quick View Layouts berfungsi untuk menampilkan model space dan 
layout pada file yang aktif dalam bentuk file gambar thumbnail.  
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Gambar 2.37 Tampilan Quick View 

2.7 Steering Wheels  
Steering Wheels merupakan salah satu fasilitas baru AutoCAD 2009 
yang fungsinya untuk memudahkan kita melihat seluruh sudut objek 
2D maupun 3D secara interaktif. Dengan Steering Wheels kita dapat 
melihat seluruh sudut objek dengan memutarnya menggunakan 
mouse.  

Steering Wheels terdiri atas beberapa bagian dengan fungsi sebagai 
berikut.  

a. Center: berfungsi untuk menentukan titik pusat perputaran (pivot) 
dari Steering Wheels. 

b. Walk: berfungsi untuk melihat objek seolah seperti orang berja-
lan, yaitu maju dan mundur.  

c. Look: berfungsi untuk melihat objek dengan cara menggerakkan 
ke kiri dan ke kanan.  

d. Up/Down: berfungsi untuk melihat objek dengan cara mengge-
rakkan ke atas dan ke bawah. 
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e. Zoom: berfungsi untuk melihat objek dengan cara memperbesar 
dan memperkecil objek. 

f. Pan: berfungsi untuk melihat objek dengan cara menggesernya 
ke arah atas, bawah, kiri, dan kanan. 

g. Orbit: berfungsi untuk melihat objek dengan cara mengge-
rakannya dengan memutar ke segala arah. 

h. Rewind: berfungsi untuk melihat objek berdasarkan perintah-
perintah yang digunakan pada objek sebelumnya dengan 
Steering Wheels. 

 
Gambar 2.38 Steering Wheels 

Metode untuk menggunakan Steering Wheels pada bidang kerja bisa 
dilakukan dengan cara sebagai berikut.  

a. Pastikan sudah terbuat objek solid seperti gambar contoh, 
pastikan juga bidang kerja yang Anda gunakan 3D Modeling.   

 
 Gambar 2.39 Objek 3D dengan sudut pandang SW Isometric 

b. Aktifkan Steering Wheels dengan cara sebagai berikut.   

 Klik tab Home > ribbon panel View.  

 Pilih ikon Steering Wheels. 



39 

 
Gambar 2.40 Letak Steering Wheels pada ribbon panel 

c. Pada perangkat Steering Wheels pilih Center kemudian 
letakkan pada tengah objek dengan cara tahan dan klik kiri 
seperti gambar di bawah.   

 
Gambar 2.41 Menentukan titik pusat perputaran (Pivot) 

d. Untuk melihat objek, Anda dapat memilih Orbit. Tahan, klik kiri 
dan putar objek sesuai dengan yang Anda butuhkan.  

 
 Gambar 2.42 Memutar objek dengan Orbit  

e. Anda dapat melihat objek dari sudut yang berbeda dengan 
memilih perintah pada perangkat Steering Wheels. Jika Anda 
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ingin melihat objek berdasarkan perintah yang sudah Anda 
kerjakan, klik Rewind.   

 
 Gambar 2.43 Menggunakan Rewind pada Steering Wheels 

f. Tekan Enter untuk mengakhiri perintah. 

2.8 ViewCube 
ViewCube merupakan salah satu fasilitas baru pada AutoCAD 2009 
yang fungsinya untuk memudahkan mengganti sudut pandang suatu 
bidang kerja, sehingga Anda dapat pula bekerja pada bidang kerja 
yang telah Anda ubah.  

Keunggulan fasilitas ini adalah Anda dapat langsung mengubah sudut 
pandang bidang kerja hanya dengan mengklik sudut pandang yang 
ada pada kubus (cube) atau dengan menggerakkannya. Sudut pan-
dang yang telah Anda ubah dapat pula dikembalikan seperti semula 
menggunakan ikon  rumah (Home) pada ViewCube. 

Sudut pandang yang terdapat pada ViewCube terdiri atas: Tampak 
Depan (Front), Atas (Top), Kanan (Right), Kiri (Left), Belakang (Back), 
dan Bawah (Bottom). Pada ViewCube juga terdapat sudut pandang 
berdasarkan arah mata angin, yang terdiri atas N (North/utara), 
S (South/selatan), W (West/barat), dan E (East/timur).   

  
Gambar 2.44 Tampilan ViewCube pada AutoCAD 2009 
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Metode untuk menggunakan ViewCube pada bidang kerja bisa 
dilakukan dengan cara sebagai berikut.  

a. Pastikan sudah terbuat objek solid, seperti gambar di bawah.   

 
 Gambar 2.45 Objek 3D dengan sudut pandang SW Isometric 

b. Klik Top pada ViewCube untuk melihat tampak atas dari objek 
3D tersebut.  

 
 Gambar 2.46 Objek 3D dengan sudut pandang Top View 

c. Klik S pada ViewCube untuk melihat tampak objek dari selatan 
(south). 
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Gambar 2.47 Objek 3D dengan sudut pandang South View 

d. Klik ikon  rumah (Home) untuk mengembalikan sudut padang 
seperti semula.  

 
Gambar 2.48 Objek 3D dengan sudut pandang South View 

e. Secara default sudut pandang akan dikembalikan menjadi seperti 
semula dengan dengan tampilan perspektif (Perspective). Untuk 
mengembalikan menjadi paralel, klik kanan pada ikon  rumah 
(Home) kemudian ubah menjadi isometri (Parallel). 
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Gambar 2.49 Proses mengubah menjadi Parallel View 

 
Gambar 2.50 Mengembalikan sudut pandang seperti semula  

 
 
 
 

### 


